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Introduction 

Overview 
With FTR Monitor™ you can record and annotate courtroom hearings, conferences, and meetings in 

multiple locations remotely, from a single program. FTR Monitor is part of a product group named FTR 

GOLD™ Monitoring Suite. 

 

FTR Monitor manages recorders on the same digital network—recorders are network-enabled PCs with 

FTR Reporter installed and running. The recorders do the work of recording audio and video, where FTR 

Monitor watches the recording activity, and controls key recording functions on any of the connected 

recorders. 

 

Once recorders are available and listed in your instance of FTR Monitor, recording can be initiated either 

by the recorder PC or by you using FTR Monitor. Either way, FTR Monitor will be monitoring the activity of 

the recording PC throughout the session. 

 

About This Guide 
This user guide assumes that you are familiar with Microsoft Windows operating systems. If you are new to 

Windows, make use of the extensive Windows help system before attempting to use FTR Monitor. 

 

This document will be used by monitoring team staff who are responsible for monitoring courtroom 

recordings. FTR GOLD Monitoring Suite will not usually be installed on a courtroom PC, so court officials 

will only use this document as a reference. 

 

Use this guide to operate FTR Monitor and troubleshooting some basic connection problems. If you need 

help installing, uninstalling, or configuring FTR Monitor, you should refer to FTR document Monitoring Suite 

Setup Guide 7.1. 

 

All images used in this guide assume you are using the Default skin—if you have selected the Classic skin, 

images will look similar but with pink coloring. 
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Getting Started 

Installation 
Monitoring Suite (including FTR Monitor) is installed on a monitoring PC (herein referred to as “a Monitor”). 

This guide assumes that FTR Monitor is already installed on the Monitor—see the Setup Guide that 

accompanies FTR GOLD Monitoring Suite, for more information on installing FTR Monitor. 
 

Upgrading Recorders 

Because FTR Monitor integrates with FTR Reporter, installing FTR Monitor may require an update of FTR 

Reporter on each recording PC that you will connect to, because the same version number of both 

software products must be installed. 
 

 
 

Licensing 
 

FTR Monitor requires one of the following license types: 

• Trial evaluation 14 days 

• Machine license – permits the use of Recording Suite on this machine only. 

• Site license – permits the use of Recording Suite on all machines on this site. 

Either a machine or a site license may have been activated during setup and no further licensing action is 

required. If a 14-day trial evaluation license was chosen, to continue to use FTR Monitoring Suite beyond 

the end of the trial period, you must activate either a machine license or a site license. 

License your copy of Recording Suite by displaying the About dialog and pressing Activate. 

 

   

                   

Note: If a recorder you are controlling with FTR Monitor has a previous version of FTR Reporter 

installed, you should match FTR Reporter on that machine to the version of FTR Monitor you are 

currently installing). 
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Activate License 
        

Use the License Activation page to select your appropriate license. 

 

 
               

Choose the first option to license this machine only: 
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On completing Step 1, you will receive a registration file. Email it to licensing@fortherecord.com to receive 

your license key. 

 

Use the license key to complete Step 2. 
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Choose the second option if you have a site license: 

 

 
 

 

When your license has been successfully activated: 
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Starting FTR Monitor 
 

You can start FTR Monitor from the desktop, or depending on your operating system, from the Start menu 

or Apps screen. 

To start FTR Monitor 

1. From the desktop, double-click the FTR Monitor icon  or 

2. Observe that the program starts.  

 

 

NOTE: On first startup, FTR Monitor will not show any recorders in the My Recorders pane. 

 

About FTR Monitor 
The About box lists information about your installation, including license validity. 

To display the About box:  

• Do one of the following: 

a. Double-click the FTR Gold logo at the top left corner of the main window or  

b. Click the Menu button , point to Help and click About FTR Monitor. 

• View the information in the About FTR Monitor dialog box. 

• Click OK to close the About box. 
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Help 
 

The following help resources are available: 

• FTR Monitoring Suite Setup Guide 

• FTR Monitor User Guide (this Guide) 

 

Viewing the Setup Guide 
The Setup Guide is published in Portable Document Format (PDF) and can be downloaded from the FTR 

website. 

Note:  The Setup Guide requires Adobe® Reader®.   

 

Viewing the User Guide 

The User Guide PDF is displayed when you click the Menu button  , point to Help and click FTR Monitor 

Help. 

 

System Information 

System information is saved in a collection of text files that are stored on your desktop. The information can 

be viewed or sent to customer support as required. 

To save system information: 

1. Click the Menu button , point to Help and click About FTR Monitor. 

2. From the About FTR Monitor dialog box, click the System Info… button. 

3. Observe a progress dialog box as system information is being saved. 

4. When complete, a message box confirms that saving was successful, and that system information is 

available from the desktop. 

To view system information: 

1. Save system information as described above. 

2. From your desktop, double-click the FTR System Information...  zip folder. 

3. From Explorer, double-click the file you wish to view. 

To send System Information: 

1. Save system information as described above. 

2. From your desktop, right-click the FTR System Information... zip folder, point to Send To and click 

Mail Recipient.  Enter the email address for your support team and send the attached system 

information files. 
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Programmers Reference 
 

When FTR Monitor is installed there is an option to include Visual Basic for Applications.  If this option is 

selected the VBA Editor and Programmers Reference are available to customize the way FTR Monitor 

works. 

To start the VBA Editor 

1. Click Start, point to All Programs, ForTheRecord then SDK. 

2. Click Visual Basic Editor. 

3. Use the VBA Help and the Programmers Reference to customize FTR Monitor. 

To view the Programmers Reference: 

1. Click Start, point to All Programs > ForTheRecord > SDK. 

2. Click Programmers Reference. 
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Working Environment 
This section of the guide describes the main components of the FTR Monitor interface. 

 

 

 

 

 
 

  

Status bar 

Level History 

Log Sheet Pane  

Tool bar Recorder bar 
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Menu 

To open the menu, click the Menu button  or press Alt  

 

 

 

 

 

 

 

 

 

 

This section of the user's guide describes each menu. 

 

File Menu 

The File menu contains the following commands: 

 

Function Description 

New… Creates a new log sheet that is based on template. 

Continue From Creates a new log sheet that is based on the active log sheet. 

Open… Opens an existing log sheet. 

Search… Opens the Search dialog box. Use this dialog box to enter search criteria so that 

you can quickly find the required log sheet. 

Close Closes the active log sheet. 

Save Copy As Saves a copy of the active log sheet to another location. 

Page Setup… Opens the page setup dialog box where you can specify the layout for printed log 

sheets. 

Print Preview Shows how the active log sheet will be printed. 

Print… Opens the Print dialog box where you can choose how much is printed. 

Properties Displays the file name and path of the active log sheet. 

Most recent list Shows the nine most recently opened log sheets. You can select any one of these 

to open. 

Exit Quits the program. 
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Edit Menu 

The Edit menu contains the following commands: 

 

Function Description 

Undo Undo last changes. 

Redo Redo last changes that you have recently undone. 

Edit Mode Switches the log sheet between read-only and editable. 

Format… Opens the format dialog box where you can specify bold, italics, underline, 

and color options. 

Cut Cuts the selected text from the log sheet and places it on the clipboard. 

Copy Copies the selected text from the log sheet and places it on the clipboard. 

Paste Pastes the contents of the clipboard to the insertion point indicated by the 

cursor position in the log sheet. 

Delete Note Deletes the current log note 

Find… Opens the Find Text dialog box where you specify what text you want to find in 

the active log sheet. 

Find Next Repeats the find action using the previous find text. 

Synchronize Note Sets the timestamp of the active log note to match the time of the associated 

content currently open in FTR Player. 

Synchronize Sheet Sets the timestamp of the active log note to match the time of the associated 

content currently open in FTR Player and then adjusts all other timestamps by 

the same amount. 

View Menu 

The View menu contains the following commands: 

 

Function Description 

Level History Show or hides the level history bar 

Record Level Window Displays the recording level in a separate re-sizable window. 

Input Level Window Displays the input levels in a separate re-sizable window. 

Always On Top If selected ensures that the FTR Reporter window is always on top of other 

programs.  

Actions Menu 

The Actions menu contains the following items: 

 

 

  

Function Description 

Link Click to set the play time in player to match the timestamp of the current log 

note. NOTE: This action is usually performed by clicking the timestamp. 

Set Range Start Sets the range start time in FTR Player to match the timestamp of the current 

log note. 

Set Range End Sets the range end time in FTR Player to match the timestamp of the current log 

note. 
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Tools Menu 

The Tools menu contains the following items: 

 

 Function Description 

Spelling Starts the spell checker. See section Spell Checking later in this guide. 

Quick Notes Opens the Quick Notes window. See section Quick Notes later in this guide 

Word List Shows or hides the word list window. See section Using Word Lists later in this 

guide. 

Templates Opens the Templates dialog box where you can manage templates. See 

Managing Templates later in this guide. 

In Court Playback Plays back a recording in the selected venue. The venue must be available in 

My Recorders. 

Tag Hearing Start Inserts a tagged note that identifies when a hearing starts. Available when FTR 

Manager - Access Edition is installed. 

Tag Hearing Stop Inserts a tagged note that identified when a hearing stops. NOTE: Available 

when FTR Manager - Access Edition is installed. 

Merge Allows merging of separate Log Sheets. 

Filter Filters Log sheets using the selected Log Note 

Options Opens a cascading menu of program option. See section Configuring FTR 

Monitor later in this guide. 
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Record Menu 

The Record menu contains the following items: 

 

Function Description 

Start or Pause Starts or pauses recording.  

Note: Your court system may require you to specify a save destination for 

recordings. If so, the following dialog will appear, requiring you to select a 

Destination each time you start a recording: 

 
For further information about the recording save destination, please refer to 

General Options, Administration Tab, on Page 34. 

The pause button will appear by default only when save destination has been 

enabled. 

 

 

 

 

 

Stop and Conclude   Concludes recording.  

 
Play At End Starts player and starts Confidence Monitoring or Live Listening. See Monitoring 

later in this guide. 

Note: If the user-selectable destination feature is enabled, after installing FTR 

Monitoring Suite, to use Live Listening first start any recorder. 

 

 

Switch to Sealed (or 

Public) 

Switches between sealed and public recording. 

My Recorders Opens the My Recorders dialog box where you can add or remove recorders from 

available recorders. 

Select Recorder Opens the Select Recorder dialog box where you can choose which recorder to 

make the selected recorder. NOTE: This action is also performed by clicking the 

recorder in My recorders. 

 

Window Menu 

The Window menu shows a list of open log sheets from which you can select one to become the active log 

sheet. If more than nine log sheets are open then the More command is available—click More to view the 

complete list of open log sheets. 

 

Help Menu 

The Help menu contains the following items: 

 

Function Description 

FTR Monitor Help Opens the main help. 

About FTR Monitor Opens the About dialog box, which shows version information and trademark 

attributions. 
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Toolbar 
The toolbar contains buttons providing quick mouse access to the main FTR Monitor functions. 

 

 
 

The following table describes each of the FTR Monitor toolbar buttons: 

 

Icon Function Action 
 

 
Menu Open the main menu 

 

 
New Create a new log sheet 

 

 
Most Recent Open the Most Recent log sheet list—select any one of these to open 

 

 
Search Locate a log sheet based on defined search criteria 

 

 
Save Copy As Open the Save Copy As dialog box—used to save a copy of the log sheet to 

another location. 
 

 
Print Print the active Log Sheet 

 

 
Print Preview Preview the active Log sheet before printing 

 

 
Edit/Read- 

only 

Toggle between edit mode and read-only mode (enable or disable Log note 

editing) 
 

 
Find Text Open the Find Text dialog box—used to locate specific words in the log 

sheet 
 

 
Spelling Start the spell checker 

 

 
Quick Notes Open the Quick Notes window 

 

 
Word List Open the Word List Window 
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Level History 
 
 

 

 

 
 

 

 

The level history bar shows up to 12 hours of recording history for each of the recorded channels. 

Recording history indicates connection, audio activity, and recording state, as shown below. 

 

The period indicated in the level history is controlled in FTR Monitor options. For more details about how 

to use the level history bar, see section Back Annotating later in this guide. 

 

Each recording channel is represented by a separate bar and the color indicates audio activity as: 

 Solid black indicates that there is no connection with the recorder. 

 Solid dark color indicates a connection but no activity in the venue. 

 Shades of color indicate activity in the venue as various participants speak on different recording 

channels. 

 

The line through the middle of the history bar indicates the recording state—the line is red when recording 

is in progress. 

The current play-time control chevron   is shown in level history bar if FTR Player is currently playing 

any part of the recording shown in the level history bar. It can be dragged to any position on the level 

history bar where a recording state exists. 
 

To view/hide the level history bar: 

1. Click the Menu button  point to View > Level History. 

2. Observe that the level history bar is displayed in the main window. 

3. Repeat to hide the level history bar. 

Enhanced Level History Bar 

If a suitable recording device is installed, you can record up to eight channels.  The line representing the 

recording state is in the middle of the Level History Bar.  When configured with an even number of 

recording channels they are symmetrically arranged around the recording status line while odd recording 

channels are distributed from the top, leaving a space at the bottom. 

Channel 1 is always the top row. 

 
 Eight-channel recording 

  

NOTE: The current play time can also be adjusted directly from FTR Player or by clicking a timestamp. If the 

current play time is set to a time that is not available in the level history period, it is not shown. 

No connection Connection but no activity Connection with activity 

Not recording Recording 

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 19 

 

 

© FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Recorder Bar 
Use the Recorder Bar to start and stop recording on selected recorder in My Recorders.  

 
 

Icon Function Description 

  
Start 

Click this button to start recording.  

Note: Your court system may require you to specify a save 

destination for recordings. If so, the following dialog will appear, 

requiring you to select a Destination each time you start a 

recording: 

 

 

 

For further information about the recording save destination, 

please refer to General Options. 

  

  
Wait Preparing to record. Advisory only. No action required.  

 
Pause 

Click this button to pause recording. Pause button is available only 

when save destination is enabled. 

 
Resume Click this button to resume recording. 

 
Stop and Conclude 

Click this button to conclude the recording. 

 

 
Play At End 

Click this button play the latest available recording - Confidence 

Monitor.  

    
Seal (or Public) Click to switch between sealed and public. 

 or  Record Time Displays the record time.  If sealed, a red border is added. 

 
Record Level Display Displays peak audio for the highest channel level.  

 Location Name Displays the department selected, along with the location name.  
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Record Time Window 

Recording time can be displayed in a separate re-sizable window. 

To open the Record Time window: 

1. From the Recorder Bar, double-click the Record Time display   

2. Observe that the Record Time Window is displayed. 

 
 

 
3. To close the window, click the close button in the top right corner. 

Record Level Window 

Recording level can be displayed in a separate re-sizable window. 

To open the Record Level window: 

1. Do one of the following: 

a. From the Recorder Bar, double-click the Record Level display  or 

b. Click the Menu button , point to View and click Record Level Window. 

2. Observe that the Record Level Window is displayed. 

 
3. To close the window, click the close button in the top right corner. 

NOTE: If the window does not appear it may be behind the main FTR Monitor window. Drag 

the main window aside to expose the Record Time Window. 
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Input Level Window 

Input levels can be displayed in a separate re-sizable window. 

To open the Input Level window: 

1. Click the Menu button , point to View and click Input Level Window. 

2. Observe that the Input Level Window is displayed. 

 

 

 
1. To close the window, click the close button in the top right corner. 

2. Observe that the Input Level Window is closed. 
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Log Sheet Pane 
Log sheets are used to annotate events that occur in the recording venue—event details are displayed in 

the Log sheet pane as Log notes. 

A log sheet includes the following components: 

• Log Sheet Tab 

• Log Sheet Heading 

• Log Notes Pane 

• Range Bar 

 

Log Sheet Tab 

Each log sheet opens in a tabbed page and the label displays one of the following titles: 

• First line of the description field 

• OR If the Description field is empty, show the Location field 

• OR If the Description and Location fields are empty, show the Date. 

 

 

The following table shows status icons that may also accompany the title: 

 

Icon Description 

 

 The log sheet is associated with the content currently open in player. 

 

 The log sheet is associated with the recorder 

 

 The log sheet is read-only and cannot be edited 
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Log Sheet Heading 

The log sheet heading contains three fields that identify the log sheet: Description, Date and 

Location fields: 
 

 
Description Field 

The Description field contains text entered by the user and is commonly used to identify the proceeding. 

This might include a matter name, matter number, presiding officer and appearances. 

 

When the Description field is not selected only the first line of text is displayed. The field can contain 

many lines of editable text, as shown below. 

 

 
 

• To expand the Description field, select it or click  to the right of the field—the field expands to reveal 

any additional lines that may be hidden. Use the scroll bar to see text further down. 

• To edit the Description contents, click anywhere in the expanded field—to add a new-line, press SHIFT + 

ENTER on your keyboard. 

• To close the expanded Description, press ENTER on your keyboard, or click anywhere outside the field. 

 

Date Field 

The Date field contains the date of the proceedings. This could be the date of the current recording or the 

date of an existing recording that is open in FTR Player. 

 
Location Field 
The Location field identifies the venue in which the proceedings occur. 

 

It is the recorder location name and the department of the current recording.  
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Log Notes Pane 

Log Notes are primarily used to describe events that occur during proceedings. They are organized and 

referenced by a Time column, a Speaker column, and a Note column. Each row represents one-time 

stamped log note. 

 
 

 
The table below describes each component of the Log Notes pane. 

 

Item Description 

Time Field As each log note is created, a time stamp is automatically entered into the time 

field. The time field cannot be directly edited. You may adjust timestamps 

using the synchronize commands. 

Speaker Field Used to identify who is speaking or the type of event that is 

occurring. 

Note Field Used to add supplementary information to assist those reviewing the matter. 

Row Selector Click this area to select the whole row (and other rows) for printing and 

saving a copy. 

Scroll Bar The scroll bar is used to navigate the log sheet if it is larger than the current 

window. 

 

  

NOTE: Because the Speaker and Note column headings can be changed, you may have 

different column titles. Changing column titles is generally done at installation time by a user 

with local administration rights. See FTR Monitor Options later in this guide. 

Tip: Speaker and Note columns in the Log Notes pane are resizable. You can resize these 

columns by dragging the column marker that separates these two columns. 

NOTE: If you resize a column to 0-width, the column is effectively hidden—the column 

marker appears red to indicate a hidden column. 
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Range Bar 

The Range bar provides a visual indication that the log sheet is linked to the content currently loaded in 

FTR Player. The Range Bar is the vertical strip to the left of the log sheet and it shows similar information to 

that displayed on the range bar in FTR Player. 

 

If the content in FTR Player is linked to the active log sheet then the Range bar shows a blue line that 

represents all loaded content. A wider shaded area on the line represents the currently selected range in 

FTR Player and is delineated by Range Start and End markers. 

 

The Current Log Note Marker indicates the most recent log note that is relevant to the currently playing 

content in FTR Player. When the current play time reaches a timestamp in the log sheet, the Current Log 

Note Marker jumps down to the relevant log note. 

 

 

  

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 26 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Status Bar 
The Status Bar shows information that monitors the status of the archive and backup systems for the 

selected recorder. 
 

 

The table below describes each component of the status bar, with descriptions for each. 

 

Item Description 

 or 

 

Indicates that network archiving is configured and working or 

there is a problem with archiving.  Contact your IT support 

staff. 

To archive: Shows how much recording is yet to be archived 

Archive space: Shows how much free space is available on the archive 

drive when configured for network archiving. 
 

 If shown, indicates that log sheets are being archived with the 

recording  

 
 

If shown, indicates that recordings are also being 

backed up to a separate local hard disk drive on the 

recording computer. 
Record Space: Indicates how much free space is available on the disk drive 

that stores the original recording. 
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My Recorders Pane 
With FTR Monitor you can manage the recording and annotation of multiple courts that are selected from 

the list of available recorders and added to the My Recorders Pane as required. 
 

 
As each recorder is added to My Recorders, a recorder button is displayed that indicates status 

information. Available recorders can be configured at any time – see section Configuring FTR Monitor later in 

this guide. 

 

Recorder Button 

Each recorder button displays status information for the listed recorders. Each recorder specified in My 

Recorders will have a Recorder button shown. 

 

A listed recorder, recording and with no connection errors 

 

A listed recorder but with a connection error 

 

The following table describes the various elements that may be shown on a recorder button. 

 

Item Description 

Recorder label The recorder label is the location name for the 

recorder.  
 The level bar shows the audio activity from the 

recorder.  

 
 

This symbol indicates that there is no connection 

to the remote recorder. 
 

 
 

This symbol indicates a problem with the recorder. 

Point to the button and read the screen tip for details. 

  
    This symbol indicates that the recorder is currently 

recording. 

   

This symbol indicates that the recorder is currently 

paused. 

My Recorders Pane 
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Quick Notes and Word List 
While working with a log sheet you can open separate display windows that show Word List and available 

Quick Notes—see sections Quick Notes and Word List later in this guide. 

 

Quick Notes 

To open the Quick Notes window, click the Quick Notes button   

 

 

Word List 

To open the Word List window, click the Word List button  . 
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Configuring FTR Monitor 
You can change many configuration options to suit the way you work. 
 

 
 

Size and Position 
When it is not maximized, the FTR Monitor window is re-sizable and can be positioned anywhere on the 

screen, using the re-size handle at the bottom right corner of the window. 

 

Sizing and Hiding Columns 
You can hide or reveal either the Note or Speaker column as required. 

To change width or hide a column: 

1. In the column title, move the pointer over the border between the Speaker and Note column. 

2. When it changes to a sizing pointer, do one of the following: 

a. Drag the column border to set the required width of the columns. 

b. To hide the column, continue to drag the column border until it collapses to become hidden. 

3. Unhide the column by dragging the border between the hidden column and the visible column. Keep 

dragging until the column re-appears and set to the required width. 
 

 
 

  

NOTE: Login on the PC as a member of the local Administrators group if you want to change 

Administration settings. 

If there is text in a hidden column then the column title appears red. 

NOTE: When you resize a column, a message is displayed asking if you want the new width 

to be applied to all log sheets. 

- If you answer Yes then all log sheets are displayed with the new width and the size is 

remembered the next time you start FTR Monitor. 

- If you answer No then only the active log sheet is affected and the size is not 

remembered the next time you start FTR Monitor. 
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Changing Program Options 
Some program options are available to all users while others are restricted to Administrators (or Power 

Users). 

To change program options, click the Menu button , point to Tools then click Options. Alternatively, 

press ALT + ENTER on your keyboard. 

 

Options are available in the following categories: 

• General – all users can change 

• Level History – all users can change 

• Available Recorders – administrators only can change 

• Administration - administrators only can change 

• Sealing - administrators only can change 
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General Options 

 

• Timestamp offset. This value specifies how much the time stamp of each new log note is automatically 

adjusted to an earlier time. The offset value is between 0 and 10 seconds. 
 

 

• Language.  Select the language you wish to use for spell checking. 

• Accessibility.  Select this option to enhance accessibility. 

 

• Skin. Switch between the Classic and Default user interfaces. Note that the functionality is identical. 

 

NOTE: The offset value compensates for the delay that occurs between the actual event 

and when it is noted. There is always a delay because it takes time to recognize the need 

for a note and entering the note. Different users can set the offset value to suit the way 

they work. 
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Level History 

• Level History period. Select the required display period from the list. The default period at installation 

time is 15 minutes. 
 

 
 

  

NOTE: When adjusting the period, the longer you set the period the more history you will 

see—a longer selected period makes it more difficult to drag the current play position 

chevron to an exact time. 
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Available Recorders 

When FTR Monitor is installed, it is necessary to add recorders to the list of available recorders. These 

recorders are then available for users to add or remove from My Recorders as required. 

 

 
 
 

 

The following recorder types can be added: 

• FTR Reporter 6.x - Any single computer installed with the FTR Reporter program. 

• ReporterDeck - Any single ReporterDeck appliance (not including ReporterDeck 2) 

• FTR Reporter Server - Any computer that is installed with FTR Reporter Server, which includes multiple 

server recorders. 
 

 

To ensure that the available recorders list shows the location name you should endeavor to add all 

recorders during installation and initial configuration of FTR Monitor. Once available recorders are added 

to My Recorders, FTR Monitor connects to the recording service and retrieves the location name—available 

recorders list is then updated to show the location name for each available recorder. 

 

  

NOTE: Available recorders can be added if you are a member of the local Administrators 

group.  

Tip: You can add FTR Reporter recorders and Reporter Decks to the Available recorders list 

even if FTR Reporter has not yet been installed or the ReporterDeck is not connected. If you do 

this, be sure to setup all recorders before you add the recorders to My Recorders. 

NOTE: If you intend to use FTR Reporter Server, it must be installed, 

configured and available on the network before attempting to add it to the 

list of Available Recorders 
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To manage Available Recorders: 

1. If you intend to add a FTR Reporter Server, be sure to install and configure the program on an 

appropriate computer and that it is accessible on the network. 

2. Click the Menu button , point to Tools and click Options. 

3. Click the Available Recorders tab. 

4. To add recorders, do the following: 

a. Click Add and drag the Add Recorder dialog box away to show the Available Recorders list. 

b. From the Add Recorder dialog box, type the name or IP address of the recorder. 

c. In the Type section, choose the type of recorder you are adding.  

d. Click Add and note that the recorder is now shown in the Available Recorders list. 

5. Repeat this step until all recorders have been added. 

6. Click Close. 

7. To remove recorders, do the following: 

a. Select the recorder you want to remove. 

b. Click Remove. 

8. From the confirmation dialog box, click Yes. 

9. Click OK to close the General Options dialog box. 
 

 
 

 

 

Administration  

These options are available if you have logged on as a member of the local Administrators group.  

 

 

 

 

 

 

IMPORTANT: Ensure that all available recorders are installed, configured and accessible 

before adding them to My Recorders. If this is not done, the location name will not be 

retrieved. 
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Show user-selectable destination list on record – If your court system requires you to specify a save 

destination for recordings, a list of destinations will have been configured during setup. Select this 

checkbox to fulfil the requirement through the following dialog: 

 

 

 

Save recordings in user-selectable destination – This option is only available if the previous option has 

been selected. Select this option if your court system requires the selection of a user-selectable destination 

and uses that selection in the recording save destination folder structure. 
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The following table clarifies the function of these options: 

 

Show user-

selectable 

destination list on 

record 

Save recordings in 

user-selectable 

destination 

Comment 

X X Both the save destination folder 

structure and the retention folder 

structure use the specified 

destination. 

X  The save destination folder 

structure does not use the specified 

destination. The retention folder 

structure does use the specified 

destination. 

 X N/A 

  Save destination is not user-

selectable. Both save and retention 

folders use the default folder 

structure. 

• New log sheet save location - There are two options available: 

➢ Folder - If selected, all new log sheets are saved to the path that is specified in Department.txt file 

relevant to the department currently chosen to be recorded. 

➢ Warehouse – if selected, all new log sheets are saved to the warehouse server location. 

• Template location - Templates store Quick Notes which are specific to a particular matter type or 

jurisdiction.  They are typically stored on a shared network folder. 

• Column titles - The default column titles are Speaker and Note. If these are not applicable in your 

organization, enter new titles. 

• Enable live streaming mode – if selected, monitor will switch to live streaming mode where the 

recording will be directly streamed from the selected FTR Reporter or FTR Reporter Server to FTR Monitor 

for better playback performance in WAN and VDI environments. For this playback mode to be available 

Streaming will also need to be enabled on the monitored system. Restart Player after switching to this 

mode. 

 

  

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 37 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Sealing Options 

If you are monitoring recorders that are configured for sealed recording, you can specify the notes that are 

automatically inserted in the log sheet whenever you switch between sealed and public recording. 
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Templates 
Templates ensure consistency in the use of terminology in each log sheet. A template is typically created 

for each matter type and is stored in a shared network folder for all users to access, as required. See 

Administration in the previous section. 

 

Each template includes a set of quick notes that are usually specific to the matter type. 

 

Template Quick Notes 

Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 

shortcut. Each template includes quick notes, which are copied to the log sheet that is based on the 

template. 
 

 
 

  

NOTE: When quick notes are edited in a log sheet, they are not changed in the template. 

The template ensures that a consistent set of quick notes is available when a new log sheet 

is created. See Log Sheet Quick Notes in the Taking Notes section, later in this guide. 

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 39 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Managing Templates 

You can create templates containing unique Quick Notes for each matter type. 

To manage templates: 

1. Click the Menu button , point to Tools and click Templates. 

2. Observe that the Templates dialog box is open. 

 
3. To create a new template, click New.  Enter a template name and click OK. 

 
4. To create a new template based on an existing template, select an existing template, and click Copy As. 

Enter a new name for the template and click OK. 

5. To rename a template, select it from the list of templates and click Rename. Change the name as 

required and click OK. 

6. To delete a template, select it from the list and click Delete.  To proceed with the deletion, click Yes in 

the confirmation dialog box. 

7. When finished you can modify the default quick notes for each template. 
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Modifying Template Quick Notes 

Once templates are created, you can define the relevant quick notes. 

To modify template quick notes: 

1. Click the Menu button , point to Tools and click Templates. 

2. From the Templates dialog box, select the template you want to modify and click Quick Notes. 

       
 

3. Observe that the Quick Notes dialog box opens. 

 

4. To add a new quick note, do the following: 

a. From the Quick notes dialog box, click New. 

b. In the New key field, enter the required keyboard shortcut. 

c. In the Label field enter the title for the quick note – e.g. Prosecutor. 
 

  

NOTE: The label field is optional but will be automatically set to the quick note text if you 

leave it blank. 
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d. In the Quick note field, enter the required word or phrase. You can include control codes to 

manage the placement of text in the log sheet. For more details, see Control Codes at the end of 

this section. 

 

e. Click Save to add the quick note to the template. 

f. Repeat this process until all quick notes are added then click Close. 

5. To change an existing quick note, do the following: 

a. From the Quick Notes window, select the quick note you want to modify and click Edit. 

b. From the Edit Quick Note dialog box, make the required changes and click OK. 

6. When all quick note changes are complete, click Close to return to the Templates dialog box. 

7. From the Templates dialog box, click Close. 
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Control Codes 

Each quick note can include one or more control codes that control the placement of text in a log 

sheet. 

 

Available control codes are: 

 

<Left> Moves the cursor to the last position in the Speaker column of 

the current log note. 

<Right> Moves the cursor to the last position in the Note column of the 

current log note. 

<End> Moves the cursor to the Speaker column of the last empty log note. 

New Line Inserts a new line in the current log note field. 

 
You can combine control codes to extend their usefulness.  The table below lists some examples. 

 
Example Result 

<END>Called & sworn<RIGHT> The text, Called & sworn, is immediately inserted in the last empty 

row of the Speaker column, a time stamp is automatically 

generated and the cursor is positioned in the adjacent Note 

column 
<END><RIGHT>Court 

adjourned<END> 

The text, Court adjourned, is immediately inserted in the Note column 

of the last empty row, a time stamp is automatically generated and the 

cursor positioned in the last empty row of the speaker column in 

readiness for the next log note to be created. 

<LEFT>Exhibit 

Police Record of Interview 

From the current cursor position moves to the speaker field of the 

current log note and inserts Exhibit.  Then creates a new line and inserts 

Police Record of Interview. 
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Recording and Monitoring 
Using FTR Monitor you can start and stop recording with multiple recorders. When FTR Monitor is installed 

a list of available recorders is created. Using this list, you can choose which recorders to work with each 

day and these are displayed in the My Recorders Pane. 

 

You can start or stop recordings and monitor the activity in each recorder using FTR Player. 

 

My Recorders 
At the start of each working day, you can modify My Recorders to include only those recorders that apply 

to you. You can add or remove recorders (one at a time) directly from the My Recorders Pane or you can 

manage multiple recorders in one operation. 
 

  NOTE:  My Recorders list can contain a maximum of fifty (50) recorders.  

 

Adding Single Recorders 

To add or remove a single recorder: 

1. To add a recorder, do the following: 

a. From the My Recorders pane, right click a vacant area and then click Add Recorder from the 

shortcut menu. 

b. From the Add Recorder dialog box, expand the list, select the required recorder, and click OK. 

 

2. To remove a recorder, do the following: 

a. Right-click the recorder you want to remove. 

b. From the shortcut menu, click Remove. 

c. If the selected recorder is currently recording a confirmation message is displayed. To proceed, click 

Yes. 
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Adding Multiple Recorders 

To add or remove multiple recorders: 

1. Click the Menu button , point to Record and click My Recorders. 

2. To add recorders, do one of the following: 

a. Select one or more recorders from the Available Recorders list and click 

b. OR Click      to add all Available Recorders. 

 

3. To remove recorders from My Recorders do one of the following: 

a. Select one or more recorders from My Recorders and click 

b. Click       to remove all recorders from My Recorders. 

4. To change the order in which recorders are displayed in My Recorders do one of the following: 

a. Select the recorder you want to move and click      to move it up the list 

b. OR Select the recorder you want to move and click      to move it down the list. 
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Start and Stop Recording 

Select any one of the recorders in the My Recorders pane  to start or stop recording. 

To start or stop the selected recorder: 

1. To select a recorder you want to start, do one of the following: 

a. Click the required recorder button in the My Recorders pane, 

b. OR Click the Menu button , point to Record and click Select Recorder.  

c. From the Select Recorder dialog box, select the required recorder and click OK. 

2. To start recording, do one of the following: 

a. From the Recorder Toolbar, click  to start recording, 

b. OR Click the Menu button , point to Record and click Start, 

c. OR Right-click the selected recorder and click Start Recording. 

3. Observe that the Start button  changes to the Wait button  while Reporter is preparing to 

record, then to the Pause button  if save destination is enabled otherwise Recording button  while 

recording is occurring. 

4. Observe that the record time display switches from dashes to an advancing time 

From  to  

5. Observe that the recorder display updates to show a recording icon. 

                    Recording icon 

6. Observe that FTR Player automatically starts and plays the active recording (Confidence Monitoring). 

7. To pause recording, click  and to resume, click . Pausing is useful when, for example, there is no 

need to change the department for the next session. 

8. Observe that the recorder display updates to show a pause icon.                                         

9. To stop recording, do one of the following: 

a. From the Recorder Toolbar, click  to stop recording, 

b. OR Click the Menu button , point to Record and click Stop, 

c. OR Right-click the selected recorder and click Stop Recording. 
 

  

  

NOTE: When you stop recording, FTR Player automatically switches from Confidence 

Monitoring to Live Listening. 

Note:  Depending on the specifications of your recording computer and the 

configured audio and/or video devices, a small delay may occur in switching to 

the Pause button. This delay is indicated by the Wait button.  
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Sealed and Public Recording 
If the selected recorder is configured for sealed recording, you can switch between sealed and public 

recording at any time. 
 

 

To switch between sealed and public mode while not recording 

1. Click the Sealed button to switch between sealed  and public  recording modes. 

2. Observe the Record Time Display to confirm the recording mode  (Sealed) or 

 (Public). 

3. To start recording, click Record , observing that the Record button has changed to   

4. Observe that the recorder button updates to show a sealed recording icon. 

                    Sealed Recording icon 

To switch between sealed and public mode while recording 

1. Click the Sealed button to switch between sealed  and public  recording modes. 

2. Observe the Record Time Display to confirm the recording mode  (Sealed) or 

 (Public). 

3. Observe that the recorder button updates to show a sealed recording icon. 

                                                                                         Sealed Recording icon 

 

 
 

  

NOTE: For sealing to be available, FTR Manager must be installed on each recorder with FTR 

Manager and FTR Reporter options configured appropriately. 

NOTE: The recording mode (sealed or public) is not affected by starting or stopping 

recording. If you were recording in sealed mode when recording was stopped then the 

recorder will resume recording in sealed mode (likewise for Public recording). 
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Monitoring using FTR Player 
The selected recorder in My Recorders can be monitored using FTR Player. You can play existing 

recordings or confidence monitor an active recording. 

 

Monitoring modes 

When used with FTR Monitor, FTR Player supports two monitoring modes: 

• Live Listening – FTR Player plays live audio, even when the selected recorder is not recording. 

• Confidence Monitoring – the selected recorder is recording and you play either the live recording 

position, or an earlier part of the recording. 

 

Live Listening 

When a selected recorder is not recording, the venue can still be monitored using live listening. When you 

stop recording, live listening is automatically started. 

To live listen: 

1. Select a recorder that is not recording. 

2. To live listen, click Play At End   from the Recorder Bar. 

3. If you move the playback position for the selected recorder (in FTR Player or in FTR Monitor), you 

can resume Live listening by clicking Play At End  from the Recorder Bar. 

 

Confidence Monitoring 

While a recording is in progress, you can playback the recorded audio stream. Confidence monitoring is 

the action of listening to an audio signal from a courtroom to ensure audio is being recorded. When you 

are confidence monitoring, the playback time is four seconds after the live recording time. 

To confidence monitor: 

1. From My Recorders, select the recorder you wish to confidence monitor 

2. If not already recording, start a recording on the selected recorder. Confidence Monitoring is 

automatically started. 
 

3. If the current play time is moved to a previous part of a recording on a selected recorder, you can 

resume Confidence monitoring by clicking Play At End . 
 

NOTE: If you change to another recorder to Confidence Monitor that recorder, playback 

in the newly selected recorder will resume at the end. 

Tip: When FTR Player is in normal view, an indicator is shown whenever you are not 

playing-at-end—to resume play-at-end, either click the play-at-end button in the FTR 

Player display window (as shown below), or the play-at-end button in FTR Monitor. 
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Player View Modes 

FTR Player can be displayed using two viewing modes. 

 
Normal View 

FTR Player normal view shows the full graphical representation of the loaded recording and provides the 

full range of features to manipulate the recording, as required. 

 

 

Compact View 

The compact player provides a basic set of features to play a recording. It takes up very little desktop space 

and is always on top of other programs (when not docked to the FTR Monitor window). 

 
 

The compact player can be positioned anywhere on your screen. To drag the compact player, click 

anywhere that is not a display or control. 
 

 

If the compact player is dragged near the FTR Monitor window it will dock on the recorder bar, adjacent to 

the location name. 

 

Button: Play-At-End Indicator:  Playing away from the end 

Tip: Transcript typists might typically place the compact player in the title bar of their word 

processor. When dragging the compact player be sure to click outside the volume slider. 
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Live Streaming View 

This view is specific to Player in FTR Gold Monitoring Suite with live streaming mode enabled. 

 

 

 

In live streaming mode, the following controls in Player are disabled. 

• Adjustment Buttons  

• Saving a Copy 

• Scan Forward 

• Scan Back 
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In Court Playback 
It is sometimes necessary for court participants to review recordings from earlier portions of the current 

hearing, or from other hearings that were heard in a different venue. 

 

Using In-Court Playback you can select and play recordings in the court that you choose from the list of 

recorders in My Recorders. 
 

 

To start an In Court Playback: 

1. Using FTR Player, open the recording that requires playback in court. 

2. Click the Menu button , point to Tools and click In Court Playback. 

3. From the In Court Playback dialog box do the following: 

a. Select the Recorder which is to perform the In Court Playback. 

b. Using FTR Player (or the timestamps in the associated log sheet), adjust the range of the recording 

that is to be played back in the selected court. 

c. Observe a summary of the selected recording and range in the confirmation pane. 

d. Once the range is selected, click Confirm. This step loads the selected range, ready for 

playback. 

e. If you are prompted for a username and password, enter the details for an account that has access 

to the local recordings folder of the court in which In Court Playback is to occur (typically your 

normal log on details). 

f. When you are ready to start the in-court playback, click Play. 

4. Click Stop to stop the In Court Playback at any time and do one of the following: 

a. Click Play to resume from the point at which you stopped 

b. Click Restart to replay from the beginning of the selected range 

c. Click Reset to define a new range 

d. Click Close to conclude the In Court Playback session. 

5. When playback of the range is complete, do one of the following: 

a. Click Restart to replay from the beginning of the selected range 

b. Click Reset to define a new range 

c. Click Close to conclude the In Court Playback session. 

NOTE: Any Available Recorders will be available for in-court playback. The range of available 

recordings is dependent on how much space is available for the local recordings folder. You 

may need to establish additional search folders to access older recordings (from the archive 

folder) or recordings that are stored in another location. 

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 51 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Taking Notes 
FTR Monitor includes powerful note-taking features that links Log notes to a precise place in a recording. A 

set of Log notes associated to a single courtroom or hearing is a Log Sheet. 

 

Using this feature you can take Log notes as each courtroom event occurs and use them later when 

reviewing the recording. As you enter each note, an automatic timestamp is added that links the note to 

the relevant place in the recording. 

 

Log Sheet Status Icons 
When you create a new log sheet, the log sheet tab includes status icons that indicate the relationship 

between the log sheet, the selected recorder and the content that is open in FTR Player. 

 

Icon Description 

 only 
This log sheet is associated with the content currently open in 

player but it is not associated with the selected recorder. Any new 

log notes are linked to the content in FTR Player and not to the 

selected recorder. 

 only 
This log sheet is associated with the selected recorder but is not 

associated with the content that is open in FTR Player. All new 

timestamps are taken from the recording time. 

 and  
 

 

 

This log sheet is associated with the selected recorder and the 

content that is open in FTR Player. All new timestamps are taken 

from the current play time in FTR Player. 

None The log sheet is not associated with any recorder in My 

Recorders or any content open in FTR Player. 

 

Creating a Log Sheet 
Normally, a new log sheet is automatically associated with the selected recorder. A log sheet and recorder 

are associated when the date and location name in the log sheet matches the date and location name of 

the selected recorder. 
 

 

There are two ways to create a new log sheet. 

• Based on a template. 

• Based on an existing log sheet. 

 
  

NOTE: If the content in FTR Player is not associated with the selected recorder, you are 

prompted to choose which content you want associated with the log sheet. 
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Create a Log Sheet Based on a Template 

As part of the installation process for FTR Monitor, templates are created that define standard quick notes 

for each matter type.  You can choose one of these templates when you create a new log sheet. 
 

When you create a log sheet this way, the quick notes contained in the template, are copied to the log 

sheet. 

To create a new log sheet from a template: 

1. Do one of the following: 

a. To create a new log sheet for one of the recorders in My Recorders, select the required recorder. 

When you select the recorder, FTR Player automatically starts live listening or confidence monitoring. 

b. To create a log sheet for an existing recording, open the recording in FTR Player. See FTR Player help 

for more details. 

2. Do one of the following: 

a. Click Menu button , point to File and click New or 

b. Click New   from the toolbar. 

3. If more than one template is available, the Choose a Template dialog box is displayed. Select the 

required template and click OK. 

4. Observe the following: 

a. If you created a new log sheet immediately after selecting a recorder (from step 1a) then the 

location name matches the Selected Recorder. 

b. If you created a new log sheet while the selected recorder is not associated with the recording that is 

open in FTR Player (from step 1b), you are prompted to choose. To associate the new log sheet with 

the selected recorder, click the Recorder option and click OK. To associate the log sheet with the 

content in FTR Player, click FTR Player option and click OK.  The location and date of the log sheet 

matches your selection. 

Continue from an Existing Log Sheet 

Some matters can take several days or weeks to reach a conclusion. To ensure that information is retained 

from one day to the next, you can create a new log sheet based on an existing log sheet. 
 

 

You can continue from: 

• A recent log sheet - Using this method, you do not have to open an earlier log sheet to continue with a 

new log sheet. 

• An old log sheet - This method requires that you open a log sheet first. This is necessary if the required 

log sheet is no longer in your list of most recently used log sheets. 

  

NOTE: Description, quick notes and word list are copied from the old log sheet to the new 

log sheet. 

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 53 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Continue From a Recent Log Sheet 

When continuing from a recent log sheet it is not necessary to open the log sheet. 

To continue from a recent log sheet: 

1. Do one of the following: 

a. To create a new log sheet for a recorder in My Recorders, select the required recorder. 

b. To create a log sheet for an existing previous recording, open the recording in FTR Player. 

2. Click Most Recent . 

3. From the Most Recent dialog box, select the required log sheet and click Continue from. 

4. Observe the following: 

a. A new log sheet is created with the current date and recorder location name. 

b. The Description field contains all the information from the recent log sheet. 

5. Make any required changes to the information in the Description field. 

6. Make any required changes to the quick notes that are copied from the recent log sheet. 

Continue From an Old Log Sheet 

When continuing from an old log sheet it must first be opened. 

To continue from an old log sheet: 

1. Search for and open the required log sheet. See File Search later in this guide. 

2. Click the Menu button , point to File and click Continue from. 

3. Observe that a new log sheet is created with the current date and recorder location name— 

Description field contains all the information from the recent log sheet. 

4. Make any required changes to the information in the Description field. 

5. Make any required changes to the quick notes that were copied from the recent log sheet. 

6. If necessary, close the older log sheet from which you continued the new log sheet. 
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Entering Heading Information 
The log sheet heading consists of the Description, Date and Location fields. 
 

 

Description Field 

Use the Description field to describe the contents of the log sheet. 

Whenever a new log sheet is started the cursor is automatically positioned in the empty Speaker field. 

 

While it is recommended that you enter a description before a matter commences it is not mandatory. You 

can enter a description at any time. 

To enter text in the Description field: 

1. Click the Description field or press CTRL+HOME. 

2. Enter the required text. As you type, the text wraps to the next line as required. 
 

  Tip:  If you wish to force a new line, press SHIFT + ENTER.  

 

3. When you have completed the entry for the Description field press ENTER. 
 

 
 

The Location Field 

The Location field is automatically completed when you create the log sheet. It will be the location 

name of the selected recorder (seen in the Recorder Bar) or the location name of the content that is 

open in FTR Player. 

 

Date Field 

The Date field is automatically completed when the log sheet is created and cannot be changed. 

 

The date that appears in this field is one of the following: 

• Computer system date – If FTR Player is not started, OR FTR Player is started but not loaded with any 

content, OR FTR Player is started and you are listening to the current recording. 

• Date of recording – If the content that is open in FTR Player does not match the recorder and you 

have associated the log sheet with FTR Player. 

  

NOTE: When you press ENTER, the cursor jumps to the last row of the log sheet. The last 

row is always an empty note. 
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Entering Notes 
When you create a new log, it is in edit mode. When you open an existing log sheet, it is in read-only mode. 

The edit/read-only mode is indicated in the log sheet tab. The active log sheet must be in edit mode and be 

associated with the recorder or the content that is open in FTR Player. 

 

NOTE:  Time stamps are taken from the associated content in FTR Player or the recorder. If FTR 

Player and recorder are both associated with the log sheet, then timestamps are taken from 

the current play time in FTR Player. 

 

NOTE 2: If you are taking live notes, be sure to play the latest available content from the 

recorder by clicking the Play At End button  from the Recorder Bar. 

 To add a log note: 

1. Do one of the following: 

a. If you want to take notes for a recorder in My Recorders, then select it and start recording. This 

action causes FTR Player to open the active recording and to play at the end – Confidence Monitor. 

b. If you want to take notes for an existing recording, open the recording with FTR Player. 

2. Create a new log sheet or open an existing log sheet that is associated. See Creating a Log Sheet earlier in  

this guide or Opening a Log Sheet later in this guide. 

3. If the log sheet is read-only (   ), click the Edit/Read-only button   from the toolbar. 

4. Do one of the following: 

a. Press ENTER from anywhere in the log sheet to move to the last blank log note row or click to select 

one of the last empty fields and start typing when you hear an event that requires a note.  This action 

automatically inserts a timestamp. 
 

  NOTE: The first key press could also be a quick note. See Quick Notes later in this guide.           

 
b. Press CTR+ENTER to add an instant timestamp at the end of the log sheet, without entering text.  

You can go back and add the text when convenient.  Use this method when events are happening 

faster than you can enter notes. 

5. If you want to add notes for earlier times in the recording, see Back Annotating later in the section. 

 

Deleting a Note 
It sometimes occurs that a log note is created in error or becomes redundant. You can delete a single log 

note whenever the log sheet is in edit mode. Multiple notes cannot be deleted in a single operation. 

To delete a log note: 

1. Do one of the following: 

a. Right-click in any column of the log note to be deleted and click Delete Log Note or 

b. Position the cursor in the note to be deleted, click the Menu button , point to Edit and click 

Delete Log Note. 

2. A dialog box prompts you to confirm the deletion. Click Yes to proceed. 
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Tagging Hearings 
In some work environments it is necessary to produce a single recording file for individual hearings during 

the day. This task is managed by a warehouse administrator using FTR Manager (Warehouse Duplication 

panel)—the duplicator searches saved log sheets for tags that identify the start and end of a hearing. 

 

As a court monitor, you will place these tags in the log notes for some/all your monitored recorders. Tags 

are inserted as Log notes using the Tag Hearing Start and Tag Hearing Stop commands. 
 

 

Tag Hearing commands prompt you for a suitable name to identify the hearing—typically a matter 

reference number or matter title. This information is used to name the mp3 recording file that is created 

by the duplication program at the end of the day—you should NOT edit the Log note once it is inserted in 

the log sheet. 
 

To insert hearing tags: 

1. Create a new log sheet and start recording. 

2. When a new hearing starts, do one of the following: 

a. Click the Menu button   , point to Tools and click Tag Hearing Start or 

b. Press Alt + H on your keyboard. 

3. In the Tag: Hearing Start dialog box, enter the hearing name. 

4. Observe that a Hearing Start tag is inserted in the log sheet. 

5. When the hearing ends, do one of the following: 

a. Click the Menu button  , point to Tools and click Tag Hearing Stop or 

b. Press Ctrl + Alt + H on your keyboard 
 

 

6. Continue with this process until all hearings are tagged. 

 

 
 

  

Tip: ALT+H and Ctrl+Alt+H are default keyboard shortcuts and can be changed in VBA code if 

required. Refer to FTR Gold Administrators guide or contact FTR Support for more details. 

NOTE: These commands are available when FTR Manager is installed. Manager is included 

in FTR GOLD 7.1 Monitoring Suite. 

Example: A typical hearing start tag looks like this: <Hearing Start> <123 of 2011> MP3 file name.   

DO NOT EDIT THIS NOTE 

IMPORTANT: Always insert a Tag Hearing Stop note when each hearing concludes, even if it is 

the last hearing of the day—the Tag Hearing Stop note is used by the warehouse duplicator to 

find the end of each hearing. 
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Back Annotating 
While taking notes with an active recording it may be necessary to add notes relating to earlier sections 

of the recording. To do this the current play time must be set to the point in the recording that requires 

a note. 

 

There are two ways to adjust the current play time: 

• Use the Level History – The level history bar in FTR Monitor provides a graphical representation of 

audio activity from each recording channel. It is very easy to see a channel become active. The period 

displayed by the Level History bar is set in FTR Monitor Options and the current play time control can be 

moved within the set time. If you want to select a time outside the level history period, you must use FTR 

Player. 

• Use FTR Player – FTR Player opens the whole recording from the selected recorder so you can select 

any time from the commencement of recording to the current time. See FTR Player User Guide for details 

on selecting a current play time. 

To back annotate using the level history bar: 

1. If level history is not available, click the Menu button , point to View and click Level History. 

2. Using the Level History bar as a guide, click the location on the bar that requires an additional note. You 

can also drag the play time control tab to the required position. 

3. Observe that the current playtime in FTR Player jumps to the selected time. 
 

 

4. Press ENTER to ensure that you are at the end of the log sheet. 

5. Start typing the note 

6. Observe that the note is inserted at the current play time displayed in FTR Player. 

7. Continue this process until all back-annotations are entered. 
 

 

To back annotate using FTR Player: 

1. Use FTR Player to locate the time requiring a note. See FTR Player help or user guide for help on 

adjusting the current play time. 

2. Press ENTER to ensure that you are at the end of the log sheet. 

3. Start typing the note. 

4. Observe that the note is inserted at the current play time displayed in FTR Player. 

5. Continue this process until all back-annotations are entered. 
 

 

  

NOTE: If FTR Player is loaded with a recording that is not associated with the recorder, the 

correct recording is automatically opened in FTR Player and the play time set accordingly. 

NOTE:  To return to live note taking, be sure to click Play At End  to play the latest available 

content from the selected recorder. 

NOTE:  To return to live note taking, be sure to click Play At End  to play the latest available 

content from the selected recorder. 
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Selecting Text 
While working with log sheets you can select portions of text in a field to: 

• Apply formatting 

• Add to quick notes 

• Add to the Word List 

• Delete 

• Copy to the clipboard 

 
You can also select several notes (rows) to: 

• Save as a new log sheet 

• Print 

• Apply formatting (maximum of 10 rows at a time) 

 

Mouse Selection 

The following steps describe how to select text or rows using the mouse. 

To select text within a log note field: 

1. Position the cursor in the first word of the required text. 

2. Do one of the following: 

a. Double click to select the current word or 

b. Drag the cursor over the required text. 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 

1. Position the pointer over the row selector for the first required log note. 

 
2. When the pointer changes ( ), click to select the current row—the row appears highlighted, as shown 

below. 

 
3. To add more rows to the selection, do one of the following: 

a. Press SHIFT and click the row selector of the last required log note, in a range of adjacent notes, to 

select all notes between 

b. OR Press CTRL and click the row selector of each log note you wish to add to the selection. 

4. Carry out the required action on the selected text. 
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Keyboard Selection 

The following steps describe how to select text or rows using the keyboard. 

To select text within a log note field: 

1. Position the cursor where you want the selection to start. 

2. Do one of the following: 

a. Press SHIFT+RIGHT to select the character to the right and repeat until the required text is selected 

or 

b. Press SHIFT+LEFT to select the character to the left and repeat until the required text is selected 

or 

c. Press SHIFT+END to select to the end of the line or 

d. Press SHIFT+HOME to select to the beginning of the line or 

e. Press SHIFT+DOWN to select to the end of the current line plus the all text in the next line - up to 

the same relative cursor position or 

f. Press SHIFT+UP to select to the beginning of the current line plus the all text in the previous 

line - back to the same relative cursor position 
 

 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 

1. Position the cursor in the first row of the required selection. 

2. Do one of the following: 

a. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in 

the last row of the required adjacent block of rows. Press CTRL+SHIFT+SPACEBAR to select all rows 

between or 

b. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in 

the next required row. Press CTRL+SPACEBAR to add the row to your selection.  Repeat this for all 

required rows or 

c. Use both previous methods to select a combination of adjacent and non-adjacent rows. 
 

 

3. Carry out the required action on the selected text. 

 
 

  

Tip: To cancel the current selection, press any cursor key. To replace the current selection, start 

typing. 

Tip: Pressing ESC (or any keyboard combination other than those described above) cancels the 

whole selection. The cursor remains in its current position when the selection is cancelled. 
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Formatting Text 
While creating notes, it is often helpful to highlight selected text in some way. You can do this by applying 

formatting to the required text or row. 

 

Available formatting options are: 

• Style - Bold, Italics and Underline or any combination 

• Color. 

 
You can apply formatting to selected text or you can simply change the format at the current cursor 

position and any new text that is entered there adopts the newly selected format. 

 

When opening the Select Format dialog box with text selected, the options indicate the current formatting 

of the selection. If part of the selection is formatted differently to other parts of the selection, then the 

relevant formatting option is shaded. Clicking a shaded option clears that format from the entire selection. 

Leaving the shaded option has no effect on that format option and the selection remains unchanged. 
 

To format log note text: 

1. Do one of the following: 

a. If you wish to apply formatting to existing text or notes, then make the required selection. See 

Selecting Text in the previous section. 

b. If you wish to apply formatting to text yet to be entered, position the cursor where the new text is to 

start. 

2. Do one of the following: 

a. Click the Menu button , point to Edit and click Format Text or 

b. Right-click to open the shortcut menu and click Format Text. 

3. From the Select Format dialog box, select a Style and Color. 

 

4. When the require format selections are made, click OK. 

 
 

  

NOTE: If you have multiple rows selected, then the format dialog box shows all options cleared. 
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Log Sheet Quick Notes 
Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 

shortcut. When a log sheet is created, quick notes are copied from the template and stored in the log 

sheet. 

 

These copied quick notes become the log sheet quick notes. Any changes made to log sheet quick notes 

are stored in the log sheet and have no effect on template quick notes. 
 

 

Viewing Quick Notes 

You can view the full list of quick notes contained in your log sheet by opening the quick notes window. While 

the quick notes window is not required to insert quick notes in a log sheet, it is required if you want to make 

changes to your quick notes. 

To view the quick notes contained in your log sheet: 

1. Do one of the following: 

a. Click the Quick Notes button   

b. OR Click the Menu button , point to Tools and click Quick Notes. 

2. Observe that the Quick Notes window is displayed. Position and size the window to suit your desktop 

layout. 

 
3. To view the full quick note, point to the required note and a screen tip is displayed. 
 

 

  

NOTE: When quick notes are edited in a log sheet, they are not changed in the template. The 

template simply ensures that a consistent set of quick notes is available when a new log sheet is 

created. Template quick notes can be edited – see section Managing Template Quick Notes earlier in 

this guide. 

NOTE: The Copy button is used for printing quick notes. See Printing Quick Notes later in this 

guide for more details. 
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Creating a New Quick Note in the Log Sheet 

There are two ways to create a new quick note. 

• Open the Quick Notes window and click the New button 

• OR Select text in your log sheet and use a keyboard shortcut to add it to the list of quick notes. 

 
Creating from Quick Notes Window 

Use this method if you want to view your current quick notes while you make changes. 

To add a new quick note: 

1. Open the Quick Notes window.  See the previous section. 

2. From the Quick Notes window, click New. 

3. Observe that the New Quick Note dialog box opens. 

 
4. Do the following: 

a. In the New key field, enter the required keyboard shortcut. 

b. In the Label field enter the title for the quick note – e.g. Prosecutor. 
 

NOTE: The label field is optional but will be automatically set to the quick note text if you leave it blank. 

 

 

5. In the Quick note field, enter the required word or phrase. You can include control codes to manage the 

placement of text in the log sheet. For more details, see Control Codes at the end of this section. 

6. Click Save to add the quick note to the template. 

7. Repeat this process until all new quick notes are added then click Close. 
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Creating from a Selection 

Use this method to create a Quick Note from a selection of text in your log sheet. 

 

To make a quick note from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new quick note. 

2. Press Shift+F3. 

3. Observe that the New Quick Note dialog box opens with the selected text shown. 

 

 
4. Enter a keyboard shortcut in the New Key box and an optional Label. 

5. Enter any relevant control codes. 

6. Click Save. 

 

  

NOTE: The Quick Notes window does not need to be open when adding new notes with this 

method 
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Editing and Deleting Quick Notes 

You can edit existing quick notes from the Quick Notes window. See Viewing Quick Notes earlier in this 

section. 

To edit existing quick notes: 

1. From the Quick Notes window, select the quick note you want to change and click Edit. 

2. Observe that the Edit Quick Note dialog box opens and that the quick note details are available for 

editing. 

 

 
 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

To delete a quick note: 

1. From the Quick Notes window, select the quick note you want to delete. 

2. Click Delete. 

3. Click Yes from the confirmation dialog box to proceed with the deletion. 
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Inserting Quick Notes in a Log Sheet 

You can insert a quick note in your log sheet using keyboard shortcuts or from the Quick Notes 

window. 

 

To insert a quick note: 

1. If you want to insert a quick note using the assigned keyboard shortcut, do the following: 

a. Position your cursor where you want the quick note inserted in your log sheet. 

b. Press the assigned keyboard shortcut for the quick note. 
 

2. If you want to select a quick note from a list then do the following: 

a. Open the Quick Notes window—see section Viewing Quick Notes earlier in this guide. 

 

b. Position your cursor where you want the quick note inserted in your log sheet. 

c. Double-click the require item from the list OR Click the require item from the list and press Enter. 

d. In the Type the item... box, start typing the label. As a label match what you type it is highlighted in 

the list.  When the required item is highlighted, stop typing and press Enter. 

3. Observe that the quick note is inserted in your log sheet. 

 

  

Tip: When inserting a quick note using keyboard shortcuts, the quick notes window does not 

need to be open. 

Tip: If you are unsure of the assigned keyboard shortcuts you can open the Quick Notes window 

and leave it open while you while you work—see section Viewing Quick Notes earlier in this guide. 
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Word List 
The Word List stores information that can be viewed in a separate window from the log notes. Typical 

uses for a word list are: 

• Spelling list - keeps a record of difficult words or names. The list becomes a reference for 

transcription staff. 

• Witness list – keeps a log of witnesses as they appear. 

 

Viewing the Word List 

You can view the Word List while you work. 

 To view the Word List: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List is now displayed in a separate window. 

 

 
 

3. Resize and position the Word List window to suit your desktop. 
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Creating a New Word List Item 

There are two ways to add items to the Word List. 

• From the Word List window – if you want to view a word list while you make changes. 

• Select text in your log sheet and use a keyboard shortcut to add it to the list. 

To add an item to the list: 

1. Open the Word List window.  See the previous section. 

2. From the Word List window, click New. 

3. From the New Item dialog box, enter the text you wish to add and click Save. 

4. Observe that the new item is now displayed in your list. 

To add a list item from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new list item. 

2. Press Shift+F4. 

3. When the item is added, a confirmation dialog box is displayed. Click OK. 

 

 
 

Editing and Deleting Word List Items 

You can edit or delete existing items from the Word List. 

To edit the Word List: 

1. From the Word List window, select the item you want to change and click Edit. 

2. Observe that the Edit Item dialog box opens and that the item details are available for editing. 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

To delete a quick note: 

1. From the Quick Notes window, select the quick note you want to delete. 

2. Click Delete. 

3. Click Yes from the confirmation dialog box to proceed with the deletion. 

 

  

NOTE: The Word List window does not need to be open when adding new items to the list using 

this method. 
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Inserting Word List Items in a Log Sheet 

You can insert a Word List item in your log sheet from the open list window. 

To insert a Word List item: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List window is open. 

 
3. Position your cursor where you want the list item inserted in your log sheet. 

4. Do one of the following: 

a. Double-click the require item from the list. 

b. Click the require item from the list and press Enter. 

5. In the Type the item box, start typing the item. As a list item matches what you type, it is highlighted in 

the list.  When the required item is highlighted, stop typing and press Enter. 

6. Observe that the list item is inserted in your log sheet. 
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Spell Checking 
FTR Monitor includes a spell checker, which can check the spelling of a selection or the whole log 

sheet. 

To spell check: 

1. To check a selection of text, make your selection first. See Selecting Text earlier in this guide. With nothing 

selected, the whole log sheet is checked. 

2. Do one of the following: 

a. Click the Menu button , point to Tools and click Spelling or 

b. Click the Spell Check button   

3. Observe that if a spelling mistake is found in any field of the log sheet, the Check Spelling dialog box is 

displayed. 

 

The log sheet field that contains the error is displayed in the dialog box and the error is 

highlighted in the Not in Dictionary box. 

 
4. From the Check Spelling dialog, take the necessary steps as required. 

5. When spell checking is finished, a confirmation message is displayed.  Click Yes. 
 

  

NOTE: You can change the language setting for the spell checker when the Check Spelling 

dialog box is displayed—click Options button. Alternatively you can set the language in 

General Options—see Changing General Options earlier in this guide. 
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Saving and Copying Log Sheets 
FTR Monitor automatically saves the active editable log sheet every 60 seconds. Automatic saves also 

occur every time you change the information in one field and then move to another field. If a problem 

arises with automatic saving, the process for recovery depends on where the log sheet is being saved. 

See Recovering From a Save Failure later in this section. 

 

You can also save a copy of the current log sheet, or a selection of notes from the current log sheet to 

another location.  After saving a copy the original log sheet remains active.  To view the copy, follow the 

normal procedure for opening a log sheet. 

 

When saving a copy you can choose one of two formats. 

• FTR Log sheet format (*.fls) 

• Web Page (.htm) format – for users that do not have access to FTR Log Notes. 

 
When saving a selection of notes, the entire Log Sheet Heading is also saved. 

To save a copy of a log sheet: 

1. If required, select the relevant notes. 

2. Click the Menu button , point to File and click Save Copy As  from the toolbar. 

3. Observe that the Save Copy As dialog box is displayed. 

 
4. From the Save Copy As dialog box do the following: 

a. Choose a drive and folder in which to copy the log sheet. 

b. Choose the format from the Save as type list. 

c. Enter the required name in the File name box or accept the default. 

5. When you are satisfied that your file name and type are correct, click Save to save a copy of the log 

sheet. 
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Recovering From a Save Failure 
The default save location for your log sheets could be to a shared network folder or to a local folder on your 

computer.  The procedure for recovery is dependent on where the save folder is located. 
 

Network Save Location 

If the save location is set to a network folder then log sheets are automatically saved to a temporary folder 

on your computer. At regular intervals the temporary log sheet is copied to the specified save location. 

 

If the shared folder becomes unavailable, the log sheet continues to be saved to the temporary folder on 

your computer and you can continue to work uninterrupted. 

• If the shared network folder becomes available before you exit the program, the temporary log sheet is 

copied to the save location – overwriting the obsolete version. All this activity occurs in the background 

without interruption to your normal procedures. 

• If the shared network folder is not available when you exit the program then a message box is 

displayed, indicating that one or more log sheets have not been saved to the specified save location. 

 
On closing the message box the temporary files are left intact. The next time FTR Monitor is started the 

temporary files are immediately saved to the specified save location. 
 

 
 

Local Save Location 

If your specified save location is local to your computer (such as a hard disk drive) and FTR Monitor is 

unable to save, a message is displayed prompting you to save a copy of the log sheet to another location. 

Once you have saved a copy then close the active log sheet, open the saved copy, and continue. 
 

 
 

Closing Log Sheets 
You can close the active log sheet or any other log sheet. 

To close the active log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to File and click Close or 

b. Right-click the tab and click Close from the shortcut menu or 

c. Click the Close button  to the right of the log sheet tabs or 

2. Observe that the previously accessed log sheet becomes the active log sheet. 

To close an inactive log sheet: 

1. Right-click the tab and click Close from the shortcut menu 

2. Observe that the currently active log sheet remains active. 

NOTE: You may be prompted with additional messages if the temporary files are older than log 

sheets of the same name in the save location.  Follow the prompts as required. 

IMPORTANT: Remember to save the copy back to the original save location when the problem is 

resolved. 
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Reviewing 
Using FTR Monitor, you can review a recording and any associated log sheets. 

Opening Log Sheets 
There are three ways to open a log sheet. 

• Open most recent 

• Open any Log Sheet 

• Search for Log Sheets 

Opening Most Recent Log Sheets 

You can open a log sheet from your list of most recently used log sheets. 

To open a recently used log sheet: 

1. Do one of the following: 

a. Click the Most Recent button . 

b. Select the required log sheet in the Most Recent dialog box and click Open. 

 

 

 

       

 

 

 

 

 

 

 

 

2. Click the Menu button , point to File and click the required log sheet from the File menu. 
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Opening any Stored Log Sheet 

Using File Open requires a knowledge of where log sheets are stored. If you don't know where to find 

your log sheets it is simpler to use File Search.  See the next section for more details. 

To open a log sheet: 

1. Click the Menu button  , point to File and click Open. 

2. From the Open dialog box, navigate to the required drive, folder, and log sheet. 

 
3. Click Open. 
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Searching for Log Sheets 
Searching provides a more efficient way of finding and opening log sheets. You can specify several 

different criteria to search for a required log sheet. 

 

 
Once Search Results are found, you can copy, delete, or print log sheets without the need to open them.  

One or more log sheets (maximum of 10) can be opened for review. 
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Search Dialog Box 

The following table describes each element of the Search dialog box as shown above. 

 

Item Description 

Description Use the Description box to enter text you know can be found in the 

Description field of the required log sheets. This is the most frequently used 

search parameter. 

Location If you know where the matter was heard, use this box to enter a Location name. 

Log Notes Use this box to enter text you know can be found in the Speaker or Note 

fields of the required log sheets. 

Search period Always use a search period to limit the scope of the search. 

Search Click this button to search with the defined criteria. 

Reset When you click this button, all text boxes are cleared and the search period is 

set to one month from the current day. 

Look in This is a list of search folders which are setup at installation time by your 

administrator or support staff 

Results When a search concludes all log sheets that match the search criteria appear in 

this list. To view more information about each log sheet point to the 

Description to open a screen tip that shows the full description. 

Open Opens one or more log sheets from the results list. 

Save Copy As Saves a copy of one or more logs sheets to another location. 

Print Click this button to print one or more log sheets from the results list. 

Delete Deletes one or more log sheets. Deleted log sheets are moved to the recycle 

bin and can be restored. 

Close Closes the Search dialog box. You can keep the dialog box open while you work 

with FTR Reporter. 

 

Performing a Search 

To search for log sheets: 

1. Do one of the following: 

a. Click the Search button   

b. OR Click the Menu button , point to File and click Search 

2. In the Search dialog box, enter search criteria as previously described. 

3. Do one of the following: 

a. Accept the folder currently displayed in the Look in box, 

b. OR Change the Look in folder by clicking Browse and navigating to the required folder, 

c. OR Click the Look in box and select folder from the list of previously used folders. 
 

  NOTE:  Within the specified Look in folder, all sub-folders will be searched.           

4. Click Search Now. Log sheets that match your search criteria are displayed in the search results list. 
 

5. Select one or more log sheets and click Open. 

NOTE: You can change the sort order of the Search Results list by clicking on the Date, Location 

or Description headings. 
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Manipulating Multiple Log Sheets 

Once you have completed a search, all log sheets matching the search criteria appear in the Search 

Results list. 

 

You can open, save a copy, print, or delete one or more of the listed log sheets. 

• To select a single log sheet, simply click the log sheet in the Search Results list. 

• To select multiple log sheets, hold the SHIFT key down while clicking the first and last log sheets in a 

series of adjacent log sheets. 

• To select multiple log sheets that are not adjacent, hold the CTRL key down while clicking each 

required log sheet. 
 

To open multiple log sheets: 

1. Perform a search for the required log sheets. 

2. Select one or more log sheets (maximum of 10) from the Search Results list. 

3. Click Open. 
 

To copy log sheets: 

1. Perform a search for the required log sheets. 

2. Select one or more log sheets (maximum of 10) from the Search Results list. 

3. From the Search dialog box click Save Copy As. 

4. From the Save Copy As dialog box choose a file name and file type. 
 

5. Click Save. 

NOTE: You can delete or save (copies of) up to one hundred (100) Log sheets—you can open or 

print a maximum of ten (10) log sheets. 

NOTE:  Log sheets will be opened in read-only mode.                                                                  

Note:  You can only change the name if a single log sheet is selected. 
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To print log sheets from the Search window: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets (maximum of 10) from Search Results and click Print. 

3. From the Print dialog box do one or both of the following: 

a. Select the Heading Pages check box to print the contents of the Description, Date and Location fields. 

b. Select the Log notes option to print all notes. 

4. Click OK. 
 

  NOTE: The selected log sheets are printed using the default printer and page setup.           

 

To delete log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets from the Search Results list. 

3. Click Delete. A dialog box prompts you to confirm the deletion. 

4. Click Yes to proceed. All selected log sheets are deleted from the current directory but are available for 

restoration from the system Recycle Bin. 

  

NOTE: The Selection option is not available when printing from the Search dialog box— see section 

Printing later in this guide for details on printing a selection from the active log sheet. 
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Associating a Log Sheet 
When you open an existing log sheet, it may not be associated with the recorder or the content that is 

open in FTR Player. To enter log notes in such a log sheet it must be associated with content that is open in 

FTR Player. 

 

Associating a log sheet with a recording makes the timestamps available for locating specific events in the 

audio. It also adds the Range Bar to the log sheet, which indicates any Range Start times, Range End times 

and the most recent log note relevant to the current playtime. 
 

An associated log sheet provides updates on the relationship between the notes and the Current Play 

Time in FTR Player. As the Current Play Time advances the Current Log Note Marker automatically 

jumps to the next relevant log note as the log note time is reached. If the log note is hidden when this 

occurs the log sheet is automatically scrolled to make it visible. 

To associate a log sheet: 

1.  Open the required log sheet. See section Opening Log Sheets earlier in this guide. 

2. Do one of the following: 

a. Click a time stamp, 

b. OR Position the cursor in a log note, click the Menu button , point to Actions and click Link. 

3. Observe that FTR Player starts—a scan begins for any recordings that include the date and 

location of the log sheet. 

4. If recording content is found with matching location name and date, it is loaded, and the current play 

time set to the log sheet timestamp. 
 

 

5. If matching audio is not found a message is displayed. Take the necessary steps to find and open the 

required audio—see the FTR Player User guide for help. 
 

 

 
  

NOTE: Search folders are scanned in the order they are defined in FTR Player properties. The 

first matching recording is opened.  See FTR Player help or user guide for details. 

NOTE: Check that the Location Name is correct. If you know that a recording does exist then 

use FTR Player to find and open it. Then, from the log sheet, click the Location field and select 

the entry that matches the date and location of the recording. Respond to any message box 

that is displayed. 
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Setting the Audio Range 
If you are only interested in a certain group of events in the log sheet, then you can limit the range of 

content available for review by setting a Range Start and Range End from the log sheet. 

 

A range can only be set from the log sheet if it is associated with the content that is open in FTR Player. 

Alternatively, you can set a range directly in FTR Player—see the FTR Player User guide for details. 

To set an audio range from the log sheet: 

1. Locate the log note that marks the beginning of the required range. 

2. Right-click the log note and click Set Range Start from the shortcut menu. 

3. Locate the log note that marks the end of the required range. 

4. Right-click the log note and click Set Range End from the shortcut menu. 
 

 
 

  

NOTE: When a Range Start or Range End time is set, a visual indication is provided in the Range 

Bar to the left of the log sheet. See section Range Bar earlier in this guide. 

http://www.fortherecord.com/


FTR Monitor™ 7.7 User Guide 

Page 80 

 © FTR Pty Ltd, 2023. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

 

Synchronizing Notes 
If a log sheet is created on a different computer from the one that created the audio recording it is 

possible that a discrepancy exists between the log note time stamps and the associated audio times for 

the related events. You can easily synchronize all timestamps in the log sheet, to the correct audio times, in 

a single step. 

 

It is also possible that a single log note is added too late to match the event in the audio. Such an 

incorrectly time stamped log note can be synchronized to the actual event in the recording. 

 

Synchronizing a Log Sheet 

Synchronize Sheet is available from the Edit menu when a log sheet is in edit mode and the content 

loaded in FTR Player, matches the location name and date of the log sheet. 

To synchronize all notes in a log sheet: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach a distinct event that is described by a specific log note and then stop. 

4. Click the Menu button , point to Edit and click Synchronize Sheet. 

5. A dialog box prompts you to confirm the synchronization.  Click Yes to proceed. 

6. Observe that all log note time stamps are adjusted by the same amount. 

 

Synchronizing a Log Note 

Synchronize Note is available from the shortcut menu or the Edit menu when a log sheet is in edit mode 

and the content loaded in FTR Player, matches the location name and date of the log sheet. 

To synchronize an individual log note with a recording: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach the distinct event for which the log note time stamp requires adjustment. 

4. Position the cursor in the log note you wish to adjust. 

5. Do one of the following: 

a. Click the Menu button , point to Edit and click Synchronize Note or 

b. Right-click the log note and click Synchronize Note from the shortcut menu. 

c. The time stamp for the selected log note is adjusted. 
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Finding Text 
While reviewing a log sheet, it may be necessary to quickly locate notes pertaining to a particular event, 

speaker, or comment. Use Find Text as a fast and effective method for searching the active log sheet 

for any occurrences of a specific word or phrase in the current log sheet. 

To find a word in a log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to Edit and click Find or 

b. Click the Find Text button . 

2. In the Find Text dialog box, enter the text you wish to find. 

 

3. Click Find. The Find Text dialog box is closed, and the first occurrence of the required text is 

highlighted in the log sheet. 

4. To locate the next occurrence of the required text press ALT+F3. 
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Filtering Notes 
The Filter tool provides a way of extracting specific notes from a log sheet. 
 

 

When the filter is activated a new log sheet opens consisting of all the notes that contain the selected 

phrase—heading information is the same as the original log sheet. 
 

To filter notes: 

1. Do one of the following: 

a. Select the word or phrase to use as the filter text or 

b. Position the cursor in the required field - this action automatically uses the entire field 

contents as the filter text. 

2. Click the Menu button , point to Tools and click Filter. 

3. From the Filter confirmation dialog box, click OK to continue. 

4. The log sheet is scanned and any notes (rows) that contain the required filter text, in the same 

column as the required filtered text, are extracted and placed in a new active log sheet, which is 

locked to editing. 

5. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As. 

  

Example: If you wish to make up a witness list you could filter the log sheet based on the phrase 

Witness called. 

WARNING: When the temporary filtered log sheet is created it is locked from editing and is not 

saved. If you close the filtered log sheet it is permanently deleted. If you want to save or edit the 

filtered log sheet then you must save a copy, then close the original (which is deleted on closing) 

and then open the copy. Switch to edit mode to make changes. 
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Merging Log Sheets 
With FTR Monitor, you can merge multiple log sheets to create a new log sheet. The heading and 

column titles of the active log sheet are used to create the heading and column titles of the newly 

merged log sheet. The Description field is modified with a new first line containing the word Merged. 

 

When the temporary merged log sheet is created it is locked to editing and is not saved. If you close the 

merged log sheet it is permanently deleted. If you want to save or edit the merged log sheet then save a 

copy, close the original (which is deleted on closing) and then open the copy. The copy can be switched to 

edit mode. 

To merge log sheets: 

1. Open the log sheets to be merged. 

2. Select the log sheet containing heading information that you want copied to the heading of the 

merged log sheet. 

3. Click the Menu button , point to Tools and click Merge. 
 

4. From the Merge confirmation dialog box, click Yes to merge the open log sheets. 

5. Observe that the merged log sheet is the active log sheet and it is locked to editing. 

6. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As. 

 

 

  

NOTE: If one or more log sheets have different dates then a warning is generated. You can still 

proceed with the merge but be cautious with log sheets of differing dates. 
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Editing Log Sheets 
You can edit the contents of an existing log sheet later. When opening an existing log sheet it is displayed 

in read-only mode.  To make changes to the log sheet, change to edit mode. 

To switch between read-only and edit modes: 

1. Click the Edit/Read-only button  . 

2. OR click the Menu button , point to Edit and click Edit Mode. 

 

Editing Existing Information 

You can edit the contents of an existing log sheet later. When opening an existing log sheet it is displayed 

in read-only mode.  To make changes to the log sheet, change to edit mode. 

To edit the log sheet: 

1. If not in edit mode, click the Edit/Read-only button  or click the Menu button , point to 

2. Edit and click Edit Mode. 

3. Enter or modify the Description field, as required. 

4. Select the log note field you wish to edit. 

5. Make changes as required. 

 

Adding a Log Note 

New notes can only be added to an existing log sheet when the log sheet is associated with the content 

that is currently open in FTR Player. 

To add a log note to a log sheet: 

1. In FTR Player, set the current play time to the time that requires a note. 

2. Press ENTER to position the cursor in the last row.  The last row is an empty log note. 

3. Enter the required log note. At the first key press the log note is time stamped instantly and 

moved to the correct chronological position in the time sheet. 

 

Deleting a Log Note 

You can delete a log note if the log sheet is in edit mode.  Multiple notes cannot be deleted. 

To delete a log note: 

1. Right-click in any column of the log note to be deleted. 

2. From the shortcut menu, click Delete Log Note. A dialog box prompts you to confirm the deletion. 

3. Click Yes to proceed. 
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Printing 

Printing Log Sheets 
You can print a log sheet or selection of notes from the active log sheet. Prior to printing you can adjust 

the way the printed page appears by changing the page setup. You can also preview the print job on 

screen before printing. 

 

If you wish to print multiple log sheets see Open, Copy, Print or Delete Multiple Log Sheets earlier in this guide. 

To print the active log sheet: 

1. To print a selection from the active log sheet, select one or more rows otherwise skip this step. 

2. Click the Menu button  , point to File and click Print or click the Print button . 

3. From the Print dialog box, do one or more of the following: 

a. Select the Heading Pages check box to print the contents of the Description, Date and Location fields. 

b. Select the Log Notes option to print notes and then select All or Selection. 
 

  NOTE: The Selection option is only available if you previously selected a range of notes.                           

 
4. Select a printer, number of copies and collation option, as required. 

5. Click OK. 
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Page Setup 

When printing notes it may be necessary to change the page setup. Page setup controls margins, headers, 

and footers on the printed page. 

To change page setup: 

1. Click the Menu button , point to File and click Page Setup. 

2. In the General tab, set margins as required. 

 

 

3. Heading page options control what is printed when you choose to print heading pages in any print job. 

a. Select Do not print header on the first page to prevent any header information being printed on 

the first heading page. 

b. Select Do not print footer on the first page to prevent any footer information being printed on 

the first heading page. 

c. Select Print separate heading page if you want to print your heading information separate from 

the log notes. 
 

  NOTE: If you only print log notes, these options do not apply.           

4. In the Header or Footer tabs, directly key in your own text or use the predefined Include buttons. To generate a 

new line (to a maximum of 10) press SHIFT+ENTER. Use the scroll bars to reveal any hidden text. 
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1. Header and footer information can be aligned left, center or right—click the appropriate alignment 

box and insert the required information using the Include buttons or by typing your own text. 

2. Other buttons are shown below: 

 

Click to include the first line of the description field - inserts <DESCRIPTION> 

Click to include the location name - inserts <LOCATION> 

Click to include the recording date - <DATE> 

Click to include the page number - <PAGE> 

Click to include the total number of pages - <TOTALPAGES> 
 

  Tip: Pages and total pages are typically entered as Page <PAGE> of <TOTALPAGES>          

 
3. Click OK to save the settings. 
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Print Previewing 

Before printing you can preview the output on screen to confirm that the page setup is correct. 

To print preview: 

1. Click the Menu button , point to Tools and click Print Preview or click the Print Preview button  

2. From the preview window do one or more of the following: 

a. View other pages by clicking the Prev Page and Next Page buttons as required. 

 

b. Click Print to print the active log sheet and close all print dialog boxes. 

 

c. Click Close to exit the Print Preview window. 
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Printing Quick Notes and Word List 
If you have limited screen space and you do not want to keep the quick notes window open, you can print 

your quick notes and display them in a prominent position near your computer. You may also need to 

print the Word List that is associated with your log sheet. 

 

Printing Quick Notes 

Printing quick notes is a two-step process that requires you to copy the quick notes to the clipboard and 

then use your text editor or word processor of choice to paste and print the document. 

To print quick notes: 

1. Click the Menu button , then point to Tools > Quick Notes. Alternatively, click the Quick 

Notes button . 

2. From the Quick Notes window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the 

clipboard. 

4. When the document is open, make any changes you require and then print the file. 

 

Printing the Word List 

Printing the word list is a two-step process that requires you to copy the list to the clipboard and then 

use your text editor or word processor of choice to paste and print the document. 

To print word list: 

1. Click the Menu button , point to Tools and click Word List or click the Word List button  . 

2. From the Word List window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the 

clipboard. 

4. When the document is open, make any changes you require and then print. 
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Keyboard Shortcuts 

General Keyboard Shortcuts 
Use these shortcuts for the main functions of FTR Monitor. 

 

To Press 

Show menu ALT or F10 

Create a new log sheet ALT + F12 (edit mode only) 

Find Text 

Find Next* 

CTRL + F3 ALT + F3 

Link F9 

Open a log sheet F3 

Open shortcut menu SHIFT + F10 

Open program Options ALT + ENTER 

Print log sheet CTRL + SHIFT + F12 

Quit program\close log sheet ALT + F4 

Save Copy As F12 

Toggle Edit/Read-only mode SHIFT + F12 
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Editing Keyboard Shortcuts 
Use these shortcuts to enter Log notes and to edit existing notes. 

 

 

To Press 

Create a new empty log note CTRL + ENTER 

Enter a new line SHIFT + ENTER 

Bold 

selection 

CTRL + B 

Italicize selection CTRL + I 

Underline selection CTRL + I 

  Copy selection OR 

Copy selection in read-only mode if        

(Accessibility is enabled) OR 

Copy current field in read-only mode if 

(Accessibility is disabled) 

CTRL + C 

Cut selection CTRL + X 

Paste CTRL + V 

Delete character to the right ALT + F4 

Delete character to the left BACKSPACE 

Add selection to quick notes SHIFT + F3 

Add selection to word list SHIFT + F4 

Undo CTRL + Z 

Redo CTRL + Y 

 

  

NOTE:  Listed shortcuts apply in edit mode only unless otherwise noted. 
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Selection Keyboard Shortcuts 
Most of the following selection shortcuts apply to a log sheet in edit mode. Those that also apply to read-

only mode are marked. 

 

To Press 

Select field contents F2 

Select character to left SHIFT + Left 

Select character to right SHIFT + Right 

Select word to left CTRL + SHIFT + Left 

Select word to right CTRL + SHIFT + Right 

Select next line. SHIFT + Down 

Select previous line. SHIFT + Up 

Select to end of line SHIFT + END 

Select to beginning of line SHIFT + HOME 

Select current log note or add current log 

note to selection (also in Read-only mode) 

CTRL + SPACEBAR 

Select all notes between the current log 

note and the last selected log note (also in 

Read-only mode) 

CTRL + SHIFT + 

SPACEBAR 
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Navigation Keyboard Shortcuts 
Use these shortcuts to move around the log sheet 

 

Press Action in Edit mode (OR read-only mode 

with Accessibility enabled) 

Action in Read-only mode with 

Accessibility  disabled 

Right Move to next character Move to next field 

Left Move to previous character Move to previous field 

Up Move up a line in a log note field 

Move and/or scroll up a line in the description or 

location field 

Move up a field 

Down Move down a line in a log note field Move and/or scroll down a line in the 

description or location field 

Move down a field 

CTRL + Right Move to beginning of next word No action 

CTRL + Left Move to beginning of previous word No action 

PAGE UP Scroll up a page Scroll up a page 

PAGE DOWN Scroll down a page Scroll down a page 

TAB Move to next field Move to next field 

SHIFT + TAB Move to previous field Move to previous field 

HOME Move to beginning of the line No action 

CTRL + 

HOME 

Move to Description field Move to Description field 

ALT + HOME Move to first Speaker Field Move to first Speaker Field 

END Move to end of line No action 

CTRL + END Move to last Speaker field Move to last Speaker field 

ENTER Move to last Speaker field No action 

Note: With Accessibility enabled, read-only navigation shortcuts behave as edit mode shortcuts. 
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